RUBRIC CLIPBOARDS

The Rubrics’ Clipboard icons (on the Icon Palette) hold the collections of rubrics that you choose from the
repertory.The rubrics in the Rubrics’ Clipboards can then be displayed by the graphs.
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The above picture portrays the Rubric Clipboards when they are empty.
When you have rubrics in a rubric clipboard they will have a dash in the icon as seen below.




COLLECTING RUBRICS-INTRODUCTION

To place a rubric into the Rubrics’ Clipboard, click on and drag the rubric from the repertory to the
appropriate clipboard and let go of the mouse button.

To put any highlighted rubric(s) into the current Rubrics’ Clipboard, press the Enter key on
your keyboard.

To see the contents of the Rubrics’ Clipboard, click on the Rubrics’ Clipboard icon. The Rubrics Clipboard
will open up and show you all the rubrics that you put into it.

To see 2 or more Rubric Clipboards-hold the shift key down and click on each clipboard you would like
to combine.

REMINDER- MACREPERTORY WILL NOT ALLOW YOU TO PUT A RUBRIC THAT HAS NO REMEDIES INTO ANY
RUBRIC CLIPBOARD.

ONCE YOU HAVE PLACED RUBRICS INTO A CLIPBOARD THERE ARE A NUMBER OF THINGS YOU CAN DO
WITH IT.THE RUBRICS CLIPBOARD IS AN ACTIVE AND INTERACTIVE WINDOW.

* You can delete a rubric

* You can drag the rubric to the Elimination Window

* You can combine 2 or more rubrics to make one larger rubric

* You can drag a rubric to the Repertory and the Repertory will open to that place.



MULTIPLE RUBRICS

You can select and drag more than one rubric by holding down the shift key as you select the rubrics.
When you select more than one rubric you must drag your selection to the clipboard instead of using the
Enter key.

Ranges

You can select a range of rubrics by selecting a rubric at the beginning of the range, holding down the shift
+ Cmd/Ctrl keys and selecting a rubric at the end of the range.This is especially useful when you want to
combine a group of sub-rubrics from the repertory into one master rubric.

Missing Rubrics

Only rubrics that have remedies can be dragged to a clipboard. If a rubric doesn’t have any remedies (a
rubric designated with a“+"), then the icon that you are dragging it to will not become highlighted and
the rubric will not be collected. So, if you thought that you included a rubric and it isn't in the Rubrics’
Clipboard, suspect that it had no remedies!

Collect symptoms for analysis by dragging the rubric from the repertory to one of the clipboards.

Example Case
If you want to add the rubric “Marriage, aversion to” to the Rubrics’ Clipboard “A”:



* Drag the rubric from the repertory to the clipboard icon labeled ‘A’ You'll see the rectangle
become highlighted. Let go of the mouse button and the rubric drops in. Continue adding
rubrics until you have entered every rubric you feel is needed to describe the case.
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Remember you can also collect your rubrics by pressing your Enter key when the rubric is highlighted.
Check to see if all your rubrics are in the Rubrics’ Clipboard A by clicking on its icon to open it.
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You can collect the rubrics from your different repertories just like any other rubric.You can continue to
switch between repertories while collecting rubrics until you feel your case is covered (See Switching
Repertories at the beginning of the Repertory section of this manual). The Rubrics Clipboard will collect
and hold all rubrics together no matter from which repertory it was selected.



Now, you may put more rubrics into the clipboard. Navigating through the sections by the black arrow in
the top left of the title box, typing to your rubric, right arrow to the sub-rubrics, selecting your rubric and
dragging it to the Rubrics Clipboard or pressing the Enter Key.

Changing the Font in the Rubric Clipboard

When the Rubric Clipboard is the active window, go to the Edit Menu and select ‘Font’ Choose whichever
one is pleasing to you. Now go back to the Edit menu and select ‘Size'



USING MULTIPLE CLIPBOARDS A-D

The purpose of the Rubrics’ Clipboards is to allow you to look at the case from several, very different angles.

You can use the different Rubrics’ Clipboard by dragging different sets of rubrics into the Rubrics’
Clipboards. Below are some helpful suggestions in the varying uses of the Rubric Clipboards.

The following are suggestions of ways you might utilize these different Clipboards. Of course, you may use
each clipboard in any you choose.

Chronicity

You can separate the rubrics based on the chronicity of the symptoms.Imagine you are seeing a
patient with an acute illness. In the course of taking the acute case you are told a number of interesting
chronic symptoms.

You could put the acute symptoms in their own clipboard by dragging them to clipboard A and put the
chronic symptoms in B.

You can then display a graph for the acute symptoms, one for the chronic and one for the two combined
(by holding the shift key down and selecting both). This approach can suggest the chronic remedy based
on itsremedy relationship with the acute.



Center of Gravity

You can put all mental/emotional symptoms in one clipboard, physical symptoms in another, and general
symptoms in another. In this way, you can see how a remedy appears in each level of your person.

Levels

Another example is to separate a patient’s symptoms as Dr. Eizayaga does. Using his system you could
drag the “lesional” or medical symptoms into Rubrics’ Clipboard A,“constitutional” or general into Rubrics’
Clipboard B, and “functional” into Rubrics’ Clipboard C.The clipboards can then be analyzed separately

or together.

This often gives a good mix of remedies from several points of view.

One Case-One Rubrics Clipboard
Of course, you can just put all the rubrics from a case in one clipboard.

Etc.

If your intent is to write a paper, you could possibly organize your rubrics in specific terms.There is no end
to the different ways you can use each clipboard.

Clipboard Tips
* Each rubrics clipboard is like a blank sheet of paper.
* Whatever your system for using each clipboard, try to be consistent with that method.

* You can rename the Title Bar of the rubric by holding down the Alt key and clicking on the title bar.The
name will appear when you open the Clipboard window, but will not change the Icon palette appearance.



USING THEME CLIPBOARDS 1-6

Clipboards 1-6 are a unique feature of MacRepertory. They can be used one of two ways.
* Rubrics Clipboards 1-6 can be used exactly like you use the Clipboards A-D.

* But they can also be used in conjunction with the Theme Palette (the sun-type circle on your icon
pallette). You can create themes that reflect different aspects of your patient case and have them
repertorized and graphed in new ways.

For instructions on how to fully go to the Rubrics Theme Palette later in this chapter of the manual.

DEFINING SYMPTOM STRENGTH IN THE RUBRICS CLIPBOARD

Once a rubric is in the Rubrics’ Clipboard, you can increase the symptom strength (underlining) by clicking on
the rubric(s) and typing a number from one to four. The remedies in a rubric with more underlining will be
more emphasized in your graph depending on the fine tune setting of Symptom Strength in the

strategy used. See Analyze Menu, Design Strategies.....

Typically if you give a rubric an underlining of three, the analysis strategies will weigh the remedies in that
symptom about three times more than the remedies in rubrics without underlines.
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Tip: Pressing a number key from 1-4 after highlighting the rubric in the clipboard will set the symptom
strength.



Underline Color

Hold down the Opt/Alt key before you click on the Edit menu. Select Underline Color and a color palette
will appear. Select your color.
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SORTING RUBRIC ORDER IN RUBRIC CLIPBOARD

.
Sorting
Rubric Name
¥ No Remedies Number of Remedies
Main Remedies Crade
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+ No Sub-Rubrics Descending
First Sub-Rubrics

All Sub-Rubrics wY

+ No Authors
Authar Numbers
Author Abbreviations

+ Remedy Count
Cross-References U

In the Rubric Menu,“Sort” is the first choice of that menu. "Sort" enables you to sort the rubrics in the
Rubrics’ Clipboards.To use it, open the Rubrics’ Clipboard and select how you want to sort the rubrics. For
more information on this feature, see the RUBRIC MENU Chapter of this manual.

“Rubric Name”
Sorting by ‘rubric name’ orders the rubrics alphabetically.

“Number of Remedies”

Sorting by “Number of Remedies” orders the rubrics based on the number of remedies in each rubric. Using
the Ascending sort puts the smallest rubrics first and the largest last.



“Grade”

Sorting by Grade orders the rubrics based on their underlining (Symptom Strength).

“Order Added”
This choice keeps the order that you originally put the rubrics into the clipboard

“Ascending”

Depending on which of the above choices you have selected,’Ascending’ will appropriately put them into
an order. eq. if you select ‘Grade’ then Ascending it will put the rubrics that have more underlines at the
bottom of the list. If you selected ‘Number of Remedies’ then then ‘Ascending’ you will see the smaller
numbered rubrics at the top of your list, and the next rubric will have more remedies.

“Descending”
Puts the order of rubrics opposite of the Ascending.



COMBINING RUBRIC’S CLIPBOARDS

If you have selected several Rubrics’ Clipboard icons (by holding down the shift key and clicking on them),
the window will show the combined rubrics. You can temporarily sort the rubrics; the individual clipboards
will not be affected.
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NAMING RUBRIC’S CLIPBOARDS
You can individually name each clipboard. Open the clipboard and hold the Opt/Alt and Cmd/Ctrl keys-
down as you click on the Title Bar (for example “Rubrics A”).
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You can rename the clipboards for one case or for all cases at all times.

Since it is better to be consistent with all your cases, this is a valuable tool.
Remember- naming your rubric clipboard title bar will not affect the appearance of the
Rubric Clipboards on the Icon Pallete. It will only affect the title bar when you open that

Rubric’s Clipboard.



COPYING RUBRICS FROM ONE CLIPBOARD TO ANOTHER

Copy single rubric

To copy single rubrics from one Rubrics’ Clipboard to another, simply drag them. This leaves the rubric in
the first clipboard as it copies it into the second.

Special Keys in MacRepertory

Enter or Return - Copy rubrics to Rubrics Clipboard

il e sl e et Copy multiple rubrics

Command + - Copy rubrics to Plus Eliminations

C d- -G brics to Mi Eliminati i
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Command Arrow - Next or previous Keynote or Keynote Book preference by going tO the Help Menu and Se|eCting
Cross Reference Key Strokes Keyboa rd ShOFtCUtS.

Change the meaning of the Command key and the
Shift key when Clicking on Rubrics

) Command Click locates the Cross Reference. c°py a range of rubrics

Command + Shift Click selects mulitple rubrics.
@ Command Click selects mulitple rubrics. To copy a range of rubrics click on the first one, press your
Command + Shift Click locates the Cross Reference. . . . .
shift key and click on the rubric you want to end with and
drag them over to your selected clipboard.

Command + Option Click - Return from cross reference to original rubric

( Cancel ) @

Duplicate all

If you want to duplicate ALL of the symptoms of one Rubrics’ Clipboard into another, drag the first Rubrics’
Clipboard icon onto the icon of the second one.



MOVING & REMOVING RUBRICS FROM THE RUBRICS CLIPBOARD

To move a single rubric (instead of copying it) from one Rubrics’ Clipboard to another, drag it with the
Opt/Alt key down. This takes the rubric out of the first clipboard and places it in the second.

To move more than one rubric, hold down the shift key as you select the rubrics.

Remove One

To remove single rubrics from a Rubrics’ Clipboard, click on the rubric so it is highlighted and press the
Delete/Backspace key, or “Cut” or “Clear” from the Edit menu.

Remove Several Rubrics

To remove several rubrics from a Rubrics’ Clipboard, select the rubrics while holding down the shift key and
press the delete key.

Remove All

To remove all of the rubrics from a Rubrics’ Clipboard, open the window and select all of the rubrics by
pressing Cmd/Ctrl + A, and the “Delete/Backspace” key.

Empty All

Open any Rubric Clipboard. Highlight all (Cmd/Ctrl + A ) of the rubrics. Hold the Opt/Alt key down and
press the delete key;A message will appear asking whether or not you want to remove all the rubrics —
choose “Yes” and all of the rubrics from ALL the clipboards will be deleted.



Dragging

Rubrics can be dragged from a Rubrics’ Clipboard to other windows in the program: Eliminations, Notes,
andRepertory Windows.

If you drag a rubric to the Repertory Window the repertory will open to that rubric.

Tip: This is very useful when you have used a rubric and later decide that you want to return to the
repertory to find a sub-rubric, a more exact rubric, or an additional, perhaps similar rubric.

MOVING ONE RUBRICTO ANOTHER CLIPBOARD AND REMOVING IT FROM THE ORIGINAL
CLIPBOARD!!!

Sometimes you will want to copy a rubric to another clipboard but also remove the rubric from the original
clipboard that you put it in. Click on the rubric, and before you drag the rubric to the new clipboard, press
and hold down the opt/alt key. Drag the rubric over to the new clipboard and let go of the click and the
opt/alt key. Now that rubric will be in the new clipboard and be removed from the original clipboard that
you putitin.



SAVING RUBRICS INTO NOTES

The Notes Window is a special case. Since it holds the text of the rubric, you can choose which information
is included with the rubric when copying: rubric name, remedies, remedy count, etc. You do this by
selecting different options from the Option menu; whatever is shown in the Rubrics’ Clipboard window will
be copied to the Notes.

For example, if you want the rubrics copied to the Notes Window with all their remedies, select “All
Remedies” from the Rubrics Menu.
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RUBRIC CLIPBOARD SYMBOLS APPEARING BEFORE A RUBRIC

You will notice symbols in front of the rubrics in the Rubrics’ Clipboard as you use the program.

A diamond (4#) identifies the rubric as one you have made. This could be a combined rubric you created, or
a rubric imported from Reference Works.

A bullet (+) identifies the rubric as a rubric from a different repertory than the one you currently have open.
An asterisk (*) means the rubric has sub-rubrics in the repertory.
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These symbols may appear differently in your program.The type of symbol that appears is dependent on
the Font that you are using.
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